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Φτιάξε μια καλύτερη ποντικοπαγίδα και όλοι θα έρθουν σε σας.

– Ralph Waldo Emerson

Η επιστήμη, η τεχνολογία και οι διάφορες μορφές τέχνης ενώνουν την ανθρωπότητα σε ένα μοναδικό 
και διασυνδεδεμένο σύστημα.

– Zhores Aleksandrovich Medvede

Καλωσήλθατε στον δυναμικό κόσμο της ανάπτυξης εφαρμογών Android για smartphones και ταμπλέ-
τες, με το Κιτ Ανάπτυξης Λογισμικού Android (Android Software Development Kit, SDK), την γλώσσα 
προγραμματισμού Java TM, το Ολοκληρωμένο Περιβάλλον Εργαλείων Ανάπτυξης Android (Android 
Development Tools IDE) και το νέο, ταχέως εξελισσόμενο Android Studio. Παρουσιάζουμε τεχνολογίες 
αιχμής για κινητή υπολογιστική για σπουδαστές, καθηγητές και επαγγελματίες προγραμματιστές λογι-
σμικού.

Android Προγραμματισμός
Μ' αυτό το μοναδικό βιβλίο μπορείτε να μάθετε το Android, ακόμη και αν δεν γνωρίζετε Java και ακόμη 
και αν είστε αρχάριος προγραμματιστής. Αυτό το βιβλίο περιλαμβάνει μια πλήρη, 300 σελίδων, εισα-
γωγή στις βασικές έννοιες προγραμματισμού με Java, τις οποίες θα χρειαστείτε, όταν αναπτύσσετε 
εφαρμογές Android. Το περιεχόμενο για την Java είναι κατάλληλο για αρχάριους προγραμματιστές.
Το βιβλίο περιέχει επίσης εκατοντάδες ερωτήσεις-απαντήσεις για το Android και ασκήσεις για ανά-

πτυξη εφαρμογών.
Όταν μελετάτε το περιεχόμενο που αναφέρεται στο Android, θα αρχίσετε να σκέφτεστε από την 

αρχή ως προγραμματιστής. Θα μελετήσετε και θα δημιουργήσετε πολλές πραγματικές εφαρμογές και 
θα αντιμετωπίσετε τις προκλήσεις, που αντιμετωπίζουν οι επαγγελματίες προγραμματιστές. Θα σας 
παραπέμψουμε στην ηλεκτρονική τεκμηρίωση και στα φόρουμ, όπου μπορείτε να βρείτε πρόσθετες 
πληροφορίες και να πάρετε απαντήσεις στις ερωτήσεις σας. Επίσης, θα σας ενθαρρύνουμε να δια-
βάσετε, να τροποποιήσετε και να εμπλουτίσετε ανοικτό πηγαίο κώδικα, ως τμήμα της διαδικασίας 
εκμάθησης.

Το Αναγνωστικό Κοινό
Υπάρχουν διάφορα αναγνωστικά κοινά γι' αυτό το βιβλίο. Συνήθως, θα χρησιμοποιείται για πανεπι-
στημιακά τμήματα ανώτερου επιπέδου και για τμήματα επαγγελματικής κατάρτισης, για ανθρώπους 
που είναι εξοικειωμένοι με τον αντικειμενοστραφή προγραμματισμό, αλλά μπορεί να μην γνωρίζουν 
Java και θέλουν να μάθουν την ανάπτυξη εφαρμογών Android.
Το βιβλίο αυτό μπορεί όμως να χρησιμοποιηθεί σε εισαγωγικά τμήματα πληροφορικής, για αρχά-

ριους προγραμματιστές. Συνιστούμε σε σχολές, που προσφέρουν πολλά εισαγωγικά θέματα πληρο-
φορικής να αφιερώνουν μια ή δύο ενότητες του μαθήματος για φιλόδοξους σπουδαστές, που έχουν 
κάποια προηγούμενη εμπειρία σε προγραμματισμό και θέλουν να εργαστούν σκληρά για να μάθουν 
αρκετά για την Java και το Android μέσα σ' ένα τμήμα. Το βιβλίο αυτό είναι ιδιαίτερα καλό για εισαγω-
γικά τμήματα δύο εξαμήνων, όπου καλύπτεται πρώτα η εισαγωγή στην Java.

 Πρόλογος
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xx  ΠΡΟΛΟΓΟΣ

Μαθήματα για Ανάπτυξη Εφαρμογών
Το 2007, το Πανεπιστήμιο του Stanford προσέφερε ένα νέο τμήμα, με όνομα Creating Engaging Facebook 
Apps (∆ημιουργία Εντυπωσιακών Εφαρμογών για το Facebook), μερικές από τις οποίες εισήλθαν στην 
λίστα των 10 κορυφαίων εφαρμογών για το Facebook, και απέδωσαν σε ορισμένους από τους σπου-
δαστές εκατομμύρια δολάρια1. Αυτό το τμήμα έτυχε ευρείας αναγνώρισης, επειδή ενθάρρυνε την 
δημιουργικότητα και την ομαδική εργασία των σπουδαστών. Πολλά κολέγια προσφέρουν σήμερα τμή-
ματα ανάπτυξης εφαρμογών, σε πολλές πλατφόρμες κοινωνικής δικτύωσης και κινητές πλατφόρμες, 
όπως το Android και το iOS. Σας ενθαρρύνουμε να διαβάσετε στο διαδίκτυο τα προγράμματα σπου-
δών για ανάπτυξη κινητών εφαρμογών και να δείτε τα βίντεο που δημιουργήθηκαν από καθηγητές 
και σπουδαστές στο YouTubeTM, για πολλά απ' αυτά τα τμήματα.

Το Οικοσύστημα του Android: Ανταγωνισμός, Καινοτομία, Εκρηκτική Ανάπτυξη και 
Ευκαιρίες
Οι πωλήσεις συσκευών Android και τα κατεβάσματα εφαρμογών Android έχουν αυξηθεί εκθετικά. Η 
πρώτη γενιά τηλεφώνων Android εμφανίστηκε τον Οκτώβριο του 2008. Μια μελέτη της Strategy 
Analytics έδειξε ότι μέχρι τον Οκτώβριο του 2013, το Android είχε μερίδιο 81.3% της παγκόσμιας αγο-
ράς smartphones, σε σύγκριση με 13.4% για την Apple, 4.1% για την Microsoft και 1% για το Blackberry2. 
Σύμφωνα με μια έρευνα της IDC, μέχρι το τέλος του πρώτου τριμήνου του 2013 το Android κατείχε 
το 56.5% της παγκόσμιας αγοράς ταμπλετών, σε σύγκριση με 39.6% για το Apple iPad και 3.7% για 
ταμπλέτες Microsoft Windows3.
Σήμερα είναι σε χρήση πάνω από ένα δισεκατομμύριο smartphones και ταμπλέτες Android4, και 

περισσότερες από 1.5 εκατομμύριο συσκευές Android ενεργοποιούνται καθημερινά5. Σύμφωνα με την 
IDC, η Samsung είναι ο κορυφαίος κατασκευαστής συσκευών Android, με πωλήσεις σχεδόν το 40% 
των συσκευών Android το τρίτο τρίμηνο του 2013.
∆ισεκατομμύρια εφαρμογές έχουν κατεβαστεί από το Google PlayTM, – την θέση αγορών της Google 

για εφαρμογές Android. Οι ευκαιρίες για προγραμματιστές εφαρμογών Android είναι τεράστιες.
Ο μεγάλος ανταγωνισμός ανάμεσα σε δημοφιλείς κινητές πλατφόρμες και εταιρείες κινητών επι-

κοινωνιών οδηγεί σε ταχεία καινοτομία και πτώση των τιμών. Ο ανταγωνισμός ανάμεσα στις δεκά-
δες εταιρίες κατασκευής συσκευών Android καθοδηγεί την καινοτομία υλικού και λογισμικού μέσα στην 
κοινότητα του Android.

Καθοδηγούμενη από Εφαρμογές Προσέγγιση
Στον πυρήνα του βιβλίου βρίσκεται η καθοδηγούμενη από εφαρμογές προσέγγιση – παρουσιάζουμε 
έννοιες μέσα στο περιβάλλον επτά πλήρων εφαρμογών Android. Αρχίζουμε κάθε κεφάλαιο με μια εισα-
γωγή στην εφαρμογή, μια δοκιμαστική εκτέλεση της εφαρμογής, που δείχνει ένα ή περισσότερα δείγ-
ματα εκτέλεσης και μια επισκόπηση των τεχνολογιών. ∆ημιουργούμε την Γ∆Χ και τα αρχεία πόρων. 
Κατόπιν προχωρούμε με μια λεπτομερή περιήγηση μέσα στον πηγαίο κώδικα της εφαρμογής, κατά 
την διάρκεια της οποίας συζητούμε τις προγραμματιστικές έννοιες και επιδεικνύουμε την λειτουργι-
κότητα των Android API, που χρησιμοποιούνται μέσα στην εφαρμογή. Όλος ο πηγαίος κώδικας δια-
τίθεται στην http://www.deitel.com/books/AndroidHTP2 και στην συνοδευτική ιστοθέση του 
βιβλίου, στην http://www.pearsonhighered.com/deitel. Συνιστούμε να έχετε ανοικτό τον 
πηγαίο κώδικα μέσα στο IDE, όταν διαβάζετε το βιβλίο. Η Εικόνα 1 αναφέρει τις εφαρμογές του βιβλίου 
και τις βασικές τεχνολογίες, που χρησιμοποιούνται για την δημιουργία κάθε εφαρμογής.

1. http://www.businessinsider.com/these-stanford-students-made-millions-taking-
aclass-on-facebook-2011-5.

2. http://blogs.strategyanalytics.com/WSS/post/2013/10/31/Android-Captures-Record-
 81-Percent-Share-of-Global-Smartphone-Shipments-in-Q3-2013.aspx.
3. http://www.idc.com/getdoc.jsp?containerId=prUS24093213.
4. http://www.android.com/kitkat.
5. http://www.technobuffalo.com/2013/04/16/google-daily-android-activations-1-5-

million.
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Εφαρμογή Τεχνολογίες

Κεφάλαιο 2, Εφαρμογή Welcome Τα εργαλεία ανάπτυξης Android (το Eclipse IDE και το ADT 
Plugin), οπτική σχεδίαση Γ∆Χ, διατάξεις, TextView, 
ImageView, διευκόλυνση προσπέλασης και διεθνοποίηση.

Κεφάλαιο 3, Εφαρμογή Tip Calculator GridLayout, LinearLayout, EditText, 
SeekBar, χειρισμός συμβάντων, NumberFormat και 
ορισμός λειτουργικότητας εφαρμογής με Java.

Κεφάλαιο 4, Εφαρμογή Twitter® 
Searches

SharedPreferences, συλλογές, ImageButton, 
ListView, ListActivity, ArrayAdapter, άρρητα 
intent και AlertDialog.

Κεφάλαιο 5, Εφαρμογή Flag Quiz Τεμάχια, μενού, προτιμήσεις, AssetManager, ενδιάμεσες 
κινήσεις, Handler, Toast, άρρητα Intent, διατάξεις 
για πολλαπλούς προσανατολισμούς συσκευών.

Κεφάλαιο 6, Εφαρμογή Cannon Game Ακρόαση για επαφές, κινήσεις καρέ-καρέ, γραφικά, ήχο, 
νημάτωση, SurfaceView και SurfaceHolder.

Κεφάλαιο 7, Εφαρμογή Doodlz ∆ισδιάστατα γραφικά, Καμβάς, Bitmap, επιταχυνσιόμετρο, 
SensorManager, συμβάντα πολυεπαφής, MediaStore, 
εκτύπωση και τρόπος πλήρους οθόνης.

Κεφάλαιο 8, Εφαρμογή Address Book AdapterView και Adapter

Εικόνα 1 Εφαρμογές του βιβλίου Android Προγραμματισμός.

Πνευματικά ∆ικαιώματα και Άδεια Χρήσης Κώδικα
Όλος ο κώδικας Android και όλες οι εφαρμογές Android αυτού του βιβλίου καλύπτονται από πνευ-
ματικά δικαιώματα της Deitel & Associates, Inc. Οι εφαρμογές Android του βιβλίου καλύπτονται από 
την άδεια χρήσης Creative Commons Attribution 3.0 Unported Licence (http://creativecommons.
org/licences/by/3.0), με την εξαίρεση ότι δεν μπορούν να επαναχρησιμοποιηθούν κατά κανέναν 
τρόπο σε εκπαιδευτικό υλικό και σε βιβλία, σε τυπωμένη ή σε ψηφιακή μορφή. Επίσης, οι συγγραφείς 
και ο εκδότης δεν δίνουν καμία εγγύηση, ρητή ή άρρητη, σε ό,τι αφορά στα προγράμματα και στην 
τεκμηρίωση που αναφέρονται σε αυτό το βιβλίο. Οι συγγραφείς και ο εκδότης δεν μπορούν να θεω-
ρηθούν υπεύθυνοι για όποιες καταστροφές μπορούν να προκύψουν από τις εφαρμογές ή από την 
παροχή, την απόδοση ή την χρήση αυτών των προγραμμάτων. Μπορείτε να χρησιμοποιήσετε τις 
εφαρμογές του βιβλίου σαν κελύφη για τις δικές σας εφαρμογές, κτίζοντας επάνω στην υπάρχουσα 
λειτουργικότητά τους. Αν έχετε ερωτήσεις, μπορείτε να έλθετε σε επαφή μαζί μας στην deitel@
deitel.com.

Μάθετε στα Γρήγορα Java και XML
Το τμήμα του βιβλίου που αναφέρεται στο Android υποθέτει ότι γνωρίζετε ήδη Java και αντικειμενο-
στραφή προγραμματισμό. Αν δεν είστε εξοικειωμένοι μ' αυτά τα θέματα, τα παραρτήματα παρέχουν 
μια συνεκτική, φιλική εισαγωγή στην Java και στις τεχνικές αντικειμενοστραφούς προγραμματισμού, 
που θα χρειαστείτε για να αναπτύξετε εφαρμογές Android. Αν ενδιαφέρεστε να μάθετε περισσότερα 
για την Java, μπορείτε να διαβάσετε το βιβλίο Java Προγραμματισμός, 10η έκδοση, που εκδίδεται από 
τον εκδοτικό οίκο Μ. Γκιούρδας (www.mgiurdas.gr).
Λόγω των βελτιωμένων εργαλείων ανάπτυξης Android, σ' αυτό το βιβλίο μπορέσαμε να απαλεί-

ψουμε σχεδόν όλες τις σημάνσεις XML. Συνεχίζουν να υπάρχουν δύο μικρά, ευκολονόητα αρχεία XML, 
τα οποία θα πρέπει να χειριστείτε. Αν δεν είστε εξοικειωμένοι με την XML, δείτε τα παρακάτω ηλε-
κτρονικά μαθήματα:

• http://www.deitel.com/articles/xml_tutorials/20060401/XMLBasics/
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• http://www.deitel.com/articles/xml_tutorials/20060401/XMLStructuringData/

• http://www.ibm.com/developerworks/xml/newto/

• http://www.w3schools.com/xml/xml_whatis.asp

Βασικά Χαρακτηριστικά του Βιβλίου
 Android SDK 4.3 και 4.4. Καλύπτουμε διάφορα νέα χαρακτηριστικά του Android Software 

Development Kit (SDK) 4.3 και 4.4. [Σημείωση: Οι εφαρμογές αυτού του βιβλίου έχουν παρα-
μετροποιηθεί, έτσι ώστε να εκτελούνται σε συσκευές Android με το SDK 4.3 ή νεότερο. Ωστόσο, 
οι περισσότερες εφαρμογές θα εργαστούν και με το 4.0 και νεότερο, αν αλλάξετε το ελάχιστο 
απαιτούμενο SDK τους.]

 Τεμάχια. Αρχίζοντας από το Κεφάλαιο 5, χρησιμοποιούμε Fragment (τεμάχια), για να δη -
μιουργήσουμε και να διαχειριστούμε τμήματα της Γ∆Χ κάθε εφαρμογής. Μπορείτε να συνδυά-
σετε αρκετά τεμάχια για να δημιουργήσετε διεπαφές χρήστη, που εκμεταλλεύονται τα μεγέθη 
οθόνης ταμπλετών. Επίσης, μπορείτε να ανταλλάξετε εύκολα τεμάχια ώστε να κάνετε τις Γ∆Χ 
σας πιο δυναμικές, όπως θα δείτε στο Κεφάλαιο 8.

 Υποστήριξη για πολλαπλά μεγέθη οθόνης και πολλαπλές αναλύσεις. Σε όλα τα κεφάλαια, 
που περιέχουν εφαρμογές, σας δείχνουμε πώς να χρησιμοποιείτε τους μηχανισμούς του Android 
για να επιλέγετε αυτόματα πόρους (διατάξεις, εικόνες, κλπ) με βάση το μέγεθος και τον προ-
σανατολισμό μιας συσκευής.

 Κάλυψη των Βασιζόμενων στο Eclipse Εργαλείων Ανάπτυξης για το Android. Το δωρεάν παρε-
χόμενο ολοκληρωμένο περιβάλλον ανάπτυξης (IDE) των εργαλείων ανάπτυξης για το Android 
(Android Development Tools, ADT), το οποίο περιλαμβάνει το Eclipse και το πρόσθετο, ADT 
plugin – σε συνδυασμό με το δωρεάν παρεχόμενο Κιτ Ανάπτυξης Java (Java Development Kit, 
JDK) παρέχουν όλο το λογισμικό που θα χρειαστείτε, για να δημιουργείτε, να εκτελείτε και να 
αποσφαλματώνετε εφαρμογές Android, να τις εξάγετε για διανομή (π.χ. να τις ανεβάζετε στο 
Google PlayTM) και να κάνετε πολλές άλλες εργασίες.

 Android Studio. Αυτό είναι το προτιμώμενο IDE για το μέλλον της ανάπτυξης εφαρμογών 
Android. Επειδή αυτό το IDE εξελίσσεται ταχέως, το συζητούμε στην:

http://www.deitel.com/books/AndroidHTP2

 Τρόπος πλήρους οθόνης. Η γραμμή κατάστασης στην κορυφή της οθόνης και τα κουμπιά 
μενού στο κάτω μέρος της οθόνης μπορούν να είναι κρυμμένα, επιτρέποντας στις εφαρμογές 
σας να καταλαμβάνουν μεγαλύτερο μέρος της οθόνης. Οι χρήστες μπορούν να προσπελάσουν 
την γραμμή κατάστασης σαρώνοντας προς τα κάτω από το επάνω μέρος της οθόνης και την 
γραμμή συστήματος (με το κουμπί Πίσω, το κουμπί αρχικής οθόνης και το κουμπί πρόσφα-
των εφαρμογών) σαρώνοντας από κάτω προς τα επάνω.

 Πλαίσιο Εργασίας Εκτύπωσης. Το Android 4.4 KitKat σας επιτρέπει να προσθέσετε λειτουργι-
κότητα εκτύπωσης στις εφαρμογές σας, όπως εντοπισμό διαθέσιμων εκτυπωτών μέσω Wi-Fi 
ή στο νέφος, επιλογή μεγέθους χαρτιού και καθορισμό των σελίδων που θα εκτυπωθούν.

 Έλεγχος σε Android Smartphones, Ταμπλέτες και στον Εξομοιωτή Android. Για να έχετε την 
καλύτερη δυνατή εμπειρία κατά την ανάπτυξη εφαρμογών, πρέπει να ελέγξετε τις εφαρμο-
γές σας σε πραγματικά smartphones και σε πραγματικές ταμπλέτες Android. Μπορείτε να έχετε 
μια καλή εμπειρία αν χρησιμοποιήσετε τον εξομοιωτή Android (δείτε την ενότητα Πριν να Αρχί-
σετε), αλλά αυτός καταναλώνει πολλούς πόρους επεξεργαστή και μπορεί να είναι αργός – ιδι-
αίτερα με παιχνίδια, τα οποία έχουν πολλά κινούμενα μέρη. Στο Κεφάλαιο 1, αναφέρουμε ορι-
σμένα χαρακτηριστικά του Android, τα οποία δεν υποστηρίζονται στον εξομοιωτή.

 Πολυμέσα. Οι εφαρμογές του βιβλίου χρησιμοποιούν μεγάλη ποικιλία δυνατοτήτων πολυμέσων 
του Android, που περιλαμβάνουν γραφικά, εικόνες, κίνηση καρέ-καρέ και ήχο.

00_CONT_android.indd   xxii00_CONT_android.indd   xxii 21/7/2014   4:26:54 μμ21/7/2014   4:26:54 μμ



xxiii  ΠΡΟΛΟΓΟΣ

 Βέλτιστες Πρακτικές Android. Συμμορφωνόμαστε με τις βέλτιστες πρακτικές του Android, 
καταδεικνύοντάς τις, όταν κάνουμε περιήγηση μέσα στον κώδικα. Για περισσότερες πληροφο-
ρίες, δείτε το http://developer.android.com/guide/practices/index.html.

 Το Περιεχόμενο της Java των Παραρτημάτων Μπορεί να Χρησιμοποιηθεί με το Java SE 6 ή 
Νεότερο.

 Χειρισμός Εξαιρέσεων της Java. Ενσωματώνουμε τον βασικό χειρισμό εξαιρέσεων στο περιε-
χόμενο της Java και μετά παρουσιάζουμε μια πληρέστερη εξέτασή του στο Παράρτημα Η. Χρη-
σιμοποιούμε τον χειρισμό εξαιρέσεων σε όλα τα κεφάλαια που αναφέρονται στο Android.

 Κλάσεις Arrays και ArrayList, Συλλογές. Το Παράρτημα Ε καλύπτει την κλάση Arrays – η 
οποία περιέχει μεθόδους για εκτέλεση συνηθισμένων χειρισμών πινάκων – και την γενική κλάση 
ArrayList – η οποία υλοποιεί μια δομή δεδομένων τύπου πίνακα, το μέγεθος της οποίας 
αλλάζει δυναμικά. Το Παράρτημα Ι εισάγει τις γενικές συλλογές της Java, που χρησιμοποιού-
νται συχνά στην εργασία με το Android.

 Πολυνημάτωση Java. Η διατήρηση της ευκολίας απόκρισης εφαρμογών είναι βασική για την 
δόμηση στιβαρών εφαρμογών Android και απαιτεί εκτεταμένη χρήση πολυνημάτωσης Android.
Το Παράρτημα Ι εισάγει τις θεμελιώδεις αρχές της πολυνημάτωσης, ώστε να μπορέσετε να 
κατανοήσετε πώς χρησιμοποιούμε την κλάση AsyncTask στο Κεφάλαιο 8.

 Παρουσίαση Γ∆Χ. Το Παράρτημα Θ εισάγει την ανάπτυξη Γ∆Χ της Java. Το Android παρέχει 
τα δικά του συστατικά Γ∆Χ, οπότε αυτό το παράρτημα παρουσιάζει μερικά συστατικά Γ∆Χ 
της Java και εστιάζεται στις κλάσεις και στις ανώνυμες εσωτερικές κλάσεις, οι οποίες χρησιμο-
ποιούνται εκτεταμένα για χειρισμό συμβάντων σε Γ∆Χ του Android.

Εργασία με Εφαρμογές Ανοικτού Πηγαίου Κώδικα
Υπάρχουν αναρίθμητες δωρεάν εφαρμογές ανοικτού πηγαίου κώδικα για το Android, που διατίθενται 
ηλεκτρονικά, οι οποίες αποτελούν εξαίρετους πόρους για να μάθετε την ανάπτυξη εφαρμογών Android. 
Σας ενθαρρύνουμε να κατεβάσετε εφαρμογές ανοικτού πηγαίου κώδικα και να διαβάσετε τον πηγαίο 
κώδικά τους, ώστε να κατανοήσετε πώς εργάζονται. Μέσα σε αυτό το βιβλίο θα βρείτε ασκήσεις 
προγραμματισμού, που σας ζητούν να τροποποιήσετε ή να εμπλουτίσετε υπάρχουσες εφαρμογές 
ανοικτού πηγαίου κώδικα. Ο στόχος μας είναι να σας δείξουμε ενδιαφέροντα προβλήματα, τα οποία 
μπορεί να σας εμπνεύσουν να δημιουργήσετε νέες εφαρμογές, χρησιμοποιώντας τις ίδιες τεχνολογίες. 
Προσοχή: Οι όροι των αδειών ανοικτού πηγαίου κώδικα μπορεί να διαφέρουν σημαντικά. Ορισμέ-
νες άδειες σας επιτρέπουν να χρησιμοποιείτε ελεύθερα τον ανοικτό πηγαίο κώδικα της εφαρμογής 
για όποιον σκοπό θέλετε, ενώ άλλες ορίζουν ότι ο κώδικας είναι διαθέσιμος μόνο για προσωπική χρήση 
– και όχι για την δημιουργία εμπορικών ή δημόσια διαθέσιμων εφαρμογών. Βεβαιωθείτε ότι έχετε δια-
βάσει τους όρους των αδειών προσεκτικά. Αν θέλετε να δημιουργήσετε μια εμπορική εφαρμογή, 
που να βασίζεται σε μια εφαρμογή ανοικτού πηγαίου κώδικα, πρέπει να βάλετε ένα δικηγόρο να 
διαβάσει την άδεια. Πρέπει να έχετε υπόψη σας ότι οι καλοί δικηγόροι κοστίζουν.

Χαρακτηρισμός Κειμένου
Χαρακτηρισμός Κώδικα. Για να κάνουμε τον κώδικά μας περισσότερο ευανάγνωστο, χρησιμοποιούμε 
τις παρακάτω συμβάσεις χαρακτηρισμού:

Τα σχόλια εμφανίζονται με αυτή την γραμματοσειρά

όλος ο υπόλοιπος κώδικας εμφανίζεται με αυτή την γραμματοσειρά

Σκίαση Κώδικα. ∆ίνουμε έμφαση σε βασικά τμήματα κώδικα μέσα σε κάθε πρόγραμμα, 
περικλείοντάς τα με γκρι ορθογώνια.

Χρήση Γραμματοσειρών για Έμφαση. Χρησιμοποιούμε διάφορες συμβάσεις γραμματοσειρών:
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 Θέτουμε τους όρους κλειδιά με έντονο κείμενο για να μπορείτε να τους αναγνωρίσετε αμέσως.

 ∆ίνουμε έμφαση στα συστατικά της οθόνης χρησιμοποιώντας γραμματοσειρά Helvetica (π.χ. 
το μενού File).

 Ο πηγαίος κώδικας προγράμματος εμφανίζεται με την εξής ειδική γραμματοσειρά (π.χ. 
int x = 5).

Σε αυτό το βιβλίο θα δημιουργείτε γραφικές διεπαφές χρήστη (Γ∆Χ, graphical user interface, GUI) 
χρησιμοποιώντας ένα συνδυασμό οπτικού προγραμματισμού (μεταφορά και απόθεση) και συγγρα-
φής κώδικα.
Χρησιμοποιούμε διαφορετικές γραμματοσειρές όταν αναφερόμαστε σε στοιχεία της Γ∆Χ μέσα στον 

κώδικα του προγράμματος και όταν αναφερόμαστε σε στοιχεία της Γ∆Χ που εμφανίζονται μέσα στο IDE:

 Όταν αναφερόμαστε σε ένα συστατικό Γ∆Χ, που δημιουργούμε μέσα σ' ένα πρόγραμμα, γρά-
φουμε το όνομα της μεταβλητής και το όνομα της κλάσης του με αυτή την γραμματοσειρά 
– π.χ., «Button saveContactButton”.

 Όταν αναφερόμαστε σε ένα συστατικό Γ∆Χ, που είναι τμήμα του IDE, γράφουμε το κείμενο 
του συστατικού με γραμματοσειρά Helvetica - π.χ., “το μενού File” ή “το κουμπί Run”.

Χρήση του Χαρακτήρα >. Χρησιμοποιούμε τον χαρακτήρα >, για να δηλώσουμε την επιλογή ενός 
στοιχείου μενού από ένα μενού. Για παράδειγμα, χρησιμοποιούμε τον συμβολισμό File > New, για να 
δηλώσουμε ότι πρέπει να επιλέξετε το στοιχείο μενού New από το μενού File.

Πηγαίος Κώδικας. Όλος ο πηγαίος κώδικας του βιβλίου διατίθεται για φόρτωση στις εξής διευθύνσεις:

http://www.deitel.com/books/AndroidHTP2
http://www.pearsonhighered.com/deitel

Στόχοι Κεφαλαίου. Κάθε κεφάλαιο αρχίζει με μια λίστα στόχων.

Εικόνες. Μέσα στο βιβλίο περιλαμβάνονται εκατοντάδες πίνακες, λίστες πηγαίου κώδικα και στιγμι-
ότυπα οθονών του Android.

Τεχνολογία λογισμικού. ∆ίνουμε έμφαση στην σαφήνεια και στην απόδοση κάθε προγράμματος, και 
επικεντρώνουμε την προσοχή μας στην δόμηση σωστά δομημένου, αντικειμενοστραφούς λογισμικού.

Ασκήσεις Αυτοελέγχου και Απαντήσεις. Κάθε κεφάλαιο περιλαμβάνει ασκήσεις αυτοελέγχου και 
απαντήσεις, για να μπορέσετε να ελέγξετε τις γνώσεις σας.

Ασκήσεις. Έχουμε προσπαθήσει σκληρά να δημιουργήσουμε ασκήσεις για ανάπτυξη εφαρμογών 
Android. Θα αναπτύξετε εφαρμογές χρησιμοποιώντας μια μεγάλη ποικιλία των τρεχουσών τεχνολο-
γιών. Όλες οι ασκήσεις προγραμματισμού απαιτούν την υλοποίηση πλήρων εφαρμογών. Θα σας 
ζητηθεί να εμπλουτίσετε τις υπάρχουσες εφαρμογές των κεφαλαίων, να αναπτύξετε παρόμοιες 
εφαρμογές, να χρησιμοποιήσετε την δημιουργικότητά σας για να αναπτύξετε τις δικές σας εφαρμογές, 
που χρησιμοποιούν τις τεχνολογίες του κεφαλαίου και να δημιουργήσετε νέες εφαρμογές, με βάση 
εφαρμογές ανοικτού πηγαίου κώδικα, που διατίθενται στο Internet (πάλι, βεβαιωθείτε ότι έχετε 
διαβάσει και συμμορφώνεστε με τους όρους της άδειας χρήσης κάθε εφαρμογής). Οι ασκήσεις 
Android περιλαμβάνουν επίσης ερωτήσεις συμπλήρωσης των κενών και ερωτήσεις σωστό/λάθος.
Στις ασκήσεις Java, θα σας ζητηθεί να θυμηθείτε σημαντικούς όρους και έννοιες, να απαντήσετε 

τι κάνουν τα τμήματα κώδικα, να αναφέρετε τι λάθος περιέχει ένα τμήμα κώδικα, να γράψετε προ-
τάσεις Java, μεθόδους και κλάσεις και να γράψετε πλήρη προγράμματα Java.

Ευρετήριο. Περιλαμβάνουμε ένα εκτεταμένο ευρετήριο για αναφορά.

Λογισμικό που Χρησιμοποιείται σε Αυτό το Βιβλίο
Όλο το λογισμικό που θα χρειαστείτε γι' αυτό το βιβλίο διατίθεται δωρεάν για κατέβασμα απ' το 
Internet. ∆είτε τις ενότητα Πριν να Αρχίσετε, για τις αντίστοιχες συνδέσεις.
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Τεκμηρίωση. Όλη η τεκμηρίωση του Android και της Java που θα χρειαστείτε για να αναπτύξετε 
εφαρμογές Android διατίθεται δωρεάν στ http://developer.android.com και στο http://www.
oracle.com/technetwork/java/javase/downloads/index.html. Η τεκμηρίωση για το Eclipse 
διατίθεται στο www.eclipse.org/documentation. Η τεκμηρίωση για το Android Studio διατίθεται 
στο http://developer.android.com/sdk/installing/studio.html.

Πριν να Αρχίσετε
Για πληροφορίες που αφορούν στην παραμετροποίηση το υπολογιστή σας, έτσι ώστε να μπορείτε 
να αναπτύξετε εφαρμογές με την Java και το Android, δείτε την ενότητα Πριν να Αρχίσετε, που ακο-
λουθεί αυτό τον Πρόλογο.

Ευχαριστίες
Ευχαριστούμε την Barbara Deitel για τις πολλές ώρες που αφιέρωσε σ' αυτό το έργο – δημιούργησε 
όλα τα Java και Android Resource Centers και μελέτησε υπομονετικά εκατοντάδες τεχνικές λεπτομέ-
ρειες.
Το βιβλίο αυτό ήταν μια συνεργατική προσπάθεια των ακαδημαϊκών και επαγγελματικών τμημά-

των της Pearson. Εκτιμούμε τις οδηγίες, την σοφία και την ενέργεια της Tracy Johnson, Εκτελεστικής 
Επιμελήτριας στην Επιστήμη των Υπολογιστών. Η Tracy και η ομάδα της διαχειρίστηκαν όλα τα ακα-
δημαϊκά μας βιβλία. Η Carole Snyder προσέλαβε τους ακαδημαϊκούς επιμελητές και διαχειρίστηκε την 
διεργασία της επιμέλειας. Ο Bob Engelhardt διαχειρίστηκε την έκδοση του βιβλίου. Επιλέξαμε τα σχέ-
δια και η Marta Samsel σχεδίασε το εξώφυλλο.
Επίσης εκτιμούμε τις προσπάθειες και την 18χρονη καθοδήγηση του μέντορα και φίλου μας Mark 

L. Taub, ∆ιευθυντή Επιμελητή της Pearson Technology Group. Ο Mark και η ομάδα του χειρίστηκαν όλα 
τα επαγγελματικά βιβλία κα τα προϊόντα βίντεο LiveLessons. Ο Kim Boedigheimer προσέλαβε και ανέ-
λαβε την διοίκηση των επαγγελματιών κριτικών για το περιεχόμενο Android. Ο John Fuller διαχειρίζε-
ται την παραγωγή όλης της σειράς βιβλίων προγραμματιστών της Deitel.
Θέλουμε να ευχαριστήσουμε τον Michael Morgano, παλιό συνάδελφό μας στην Deitel & Associates, 

Inc., και τώρα προγραμματιστή Android στην Imerj™, ο οποίος μα βοήθησε στην συγγραφή των πρώ-
των εκδόσεων αυτού του βιβλίου. Ο Michael είναι ένας εξαιρετικά ταλαντούχος προγραμματιστής.

Κριτικοί των Βιβλίων Android για Προγραμματιστές και Android Προγραμματισμός, 
Πρόσφατες Εκδόσεις:
Θέλουμε να ευχαριστήσουμε τους κριτικούς της πρώτης και της δεύτερης έκδοσης του βιβλίων μας. 
Μελέτησαν εξονυχιστικά το κείμενο και τον κώδικα και μας έδωσαν αναρίθμητες προτάσεις, για να 
βελτιώσουμε την παρουσίαση: Paul Beusterien (Principal, Mobile Developer Solutions), Eric J. Bowden, 
COO (Safe Driving Systems, LLC), Tony Cantrell (Georgia Northwestern Technical College), Ian G. Clifton 
(Ανεξάρτητος Προγραμματιστής και Προγραμματιστής Εφαρμογών Android), Daniel Galpin (Android 
Advocate και συγγραφέας του Intro to Android Application Development), Jim Hathaway (Application 
Developer, Kellogg Company), Douglas Jones (Senior Software Engineer, Fullpower Technologies), Charles 
Lasky (Nagautuck Community College), Enrique Lopez-Manas (Lead Android Architect, Sixt, και Καθηγητής 
της Επιστήμης των Υπολογιστών στο Πανεπιστήμιο Alcala, Madrid), Sebastian Nykopp (Chief Architect, 
Reaktor), Michael Pardo (Android Developer, Mobiata), Ronan “Zero” Schwarz (CIO, OpenIntents), Arijit 
Sengupta (Wright State University), Donald Smith (Columbia College), Jesus Ubaldo Quevedo-Torrero 
(University of Wisconsin, Parkside), Dawn Wick (Southwestern Community College) και Frank Xu (Gannon 
University).

Κριτικοί του Βιβλίου Java Προγραμματισμός, Πρόσφατες Εκδόσεις
Lance Andersen (Oracle), Soundararajan Angusamy (Sun Microsystems), Joseph Bowbeer (Consultant), 
William E. Duncan (Louisiana State University), Diana Franklin (University of California, Santa Barbara), 
Edward F. Gehringer (North Carolina State University), Huiwei Guan (Northshore Community College), 
Ric Heishman (George Mason University), Dr. Heinz Kabutz (JavaSpecialists.eu), Patty Kraft (San Diego 
State University), Lawrence Premkumar (Sun Microsystems), Tim Margush (University of Akron), Sue 
McFarland Metzger (Villanova University), Shyamal Mitra (The University of Texas at Austin), Peter Pilgrim 
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(Consultant), Manjeet Rege, Ph.D. (Rochester Institute of Technology), Manfred Riem (Java Champion, 
Consultant, Robert Half), Simon Ritter (Oracle), Susan Rodger (Duke University), Amr Sabry (Indiana Uni-
versity), Jose Antonio Gonzαlez Seco (Parliament of Andalusia), Sang Shin (Sun Microsystems), S. Sivaku-
mar (Astra Infotech Private Limited), Raghavan “Rags” Srinivas (Intuit), Monica Sweat (Georgia Tech), Vinod 
Varma (Astra Infotech Private Limited) and Alexander Zuev (Sun Microsystems).
Καθώς διαβάζετε αυτό το βιβλίο, θα θέλαμε να μας στείλετε τα σχόλια, τις κριτικές και τις προ-

τάσεις σας για να βελτιώσουμε το βιβλίο. Στείλτε όλα τα σχόλιά σας στην διεύθυνση:

deitel@deitel.com

Θα σας απαντήσουμε άμεσα. ∆ιασκεδάσαμε πολύ όταν γράφαμε αυτό το βιβλίο, ελπίζουμε να δια-
σκεδάσετε, όταν το διαβάζετε!

Paul Deitel
Harvey Deitel
Abbey Deitel

Οι Συγγραφείς
Ο Paul J. Deitel, ∆ιευθύνων Σύμβουλος και Γενικός Τεχνικός ∆ιευθυντής της Deitel & Associates είναι 
απόφοιτος του MIT, όπου σπούδασε Πληροφορική. Κατέχει τις πιστοποιήσεις Java Certified Programmer 
και Java Certified Developer και είναι Oracle Java Champion. Μέσω της Deitel & Associates, Inc., έχει 
παραδώσει μαθήματα προγραμματισμού σε όλο τον κόσμο σε πελάτες, που περιλαμβάνουν τις εται-
ρείες Cisco, IBM, Siemens, Sun Microsystems, Dell, Fidelity, NASA στο Κέντρο ∆ιαστήματος Kennedy, 
National Server Storm Laboratory, White Sands Missile Range, Rogue Wave Software, Boeing,SunGard 
Higher Education, Nortel Networks, Puma, iRobot, Invensys και πολλές άλλες. Αυτός μαζί με τον Dr. 
Harvey M. Deitel, είναι οι δημοφιλέστεροι συγγραφείς βιβλίων σε θέματα γλωσσών προγραμματισμού.
Ο Dr. Harvey M. Deitel, Πρόεδρος του ∆ιοικητικού Συμβουλίου και Γενικός ∆ιευθυντής Στρατηγι-

κής της Deitel & Associates, Inc., έχει 50 χρόνια εμπειρίας στον τομέα των υπολογιστών. Ο Dr. Deitel 
πήρε το B.S. και το M.S. του από το MIT και το διδακτορικό του από το Πανεπιστήμιο Boston. Έχει 
εκτεταμένη διδακτική εμπειρία σε κολέγια, που περιλαμβάνουν πολλά χρόνια εμπειρίας στο τμήμα 
Computer Science του Κολεγίου Boston, όπου διατέλεσε και πρόεδρος, πριν να ιδρύσει το 1991 την 
Deitel & Associates, Inc., μαζί με τον υιό του, Paul J. Deitel. Αυτός και ο Paul είναι από κοινού συγγρα-
φείς αρκετών δεκάδων βιβλίων και πακέτων πολυμέσων, και συνεχίζουν να συγγράφουν κ.ά. Τα βιβλία 
τους έχουν μεταφραστεί στα Ιαπωνικά, Γερμανικά, Ρωσικά, Ισπανικά, Κινεζικά, Κορεάτικα, Γαλλικά, 
Πολωνικά, Ιταλικά, Πορτογαλικά, Ελληνικά και Τουρκικά, και έχουν κερδίσει παγκόσμια αναγνώριση. 
Ο Dr. Deitel έχει διδάξει σε εκατοντάδες επαγγελματικά σεμινάρια σε μεγάλους οργανισμούς, σε ακα-
δημαϊκά ιδρύματα, σε κυβερνητικούς οργανισμούς και σε στρατιωτικά εκπαιδευτικά ιδρύματα.
Η Abbey Deitel, Πρόεδρος της Deitel & Associates, Inc., είναι απόφοιτος του Carnegie Mellon 

University, Tepper School of Management, όπου πήρε το πτυχίο της B.S. στο Βιομηχανικό Μάνατζμεντ. 
∆ιαχειρίζεται τις επιχειρησιακές λειτουργίες της Deitel & Associates, Inc. για 16 χρόνια. Έχει συνεισφέ-
ρει σε πολλές εκδόσεις της Deitel & Associates και, μαζί με τους Paul και Harvey έχει συγγράψει τα 
βιβλία Android for Programmers: An App-Driven Approach, 2/e, iPhone for Programmers: An App-Driven 
Approach, Internet & World Wide Web How to Program, 5/e, Visual Basic 2012 How to Program 6/e και 
Simply Visual Basic 2010, 5/e.
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Σ' αυτήν την ενότητα θα διαμορφώσετε τον υπολογιστή σας, για να μπορέσετε να τον χρησιμοποιή-
σετε με αυτό το βιβλίο. Τα εργαλεία ανάπτυξης Android συχνά ενημερώνονται. Πριν να διαβάσετε 
αυτή την ενότητα, ελέγξτε την ιστοθέση του βιβλίου, στο

http://www.deitel.com/books/AndroidHTP2/

για να δείτε αν έχουμε αναρτήσει κάποια ενημερωμένη έκδοση.

Συμβάσεις Γραμματοσειρών και Ονομασίας
Χρησιμοποιούμε γραμματοσειρές για να διακρίνουμε ανάμεσα σε συστατικά της οθόνης (όπως είναι 
τα ονόματα μενού και τα στοιχεία μενού) και στον κώδικα Java ή σε εντολές. Η σύμβαση που χρησι-
μοποιούμε είναι να εμφανίζουμε τα συστατικά της οθόνης με αυτή την γραμματοσειρά (π.χ., μενού 
Project) και να εμφανίζουμε τα ονόματα αρχείων, τον κώδικα Java και τις εντολές με αυτή την γραμ-
ματοσειρά (π.χ., την λέξη-κλειδί public ή την κλάση Activity). Όταν καθορίζουμε εντολές που 
θα επιλέξουμε μέσα σε μενού, χρησιμοποιούμε τον συμβολισμό >, για να δηλώσουμε ένα στοιχείο 
μενού, που επιλέγεται. Για παράδειγμα, Window > Preferences δηλώνει ότι πρέπει να επιλέξετε το 
στοιχείο μενού Preferences από το μενού Window.

Απαιτήσεις Λογισμικού και Υλικού
Για να αναπτύξετε εφαρμογές Android χρειάζεστε ένα σύστημα Windows®, Linux ή Mac OS X. Για να 
βρείτε τις πιο πρόσφατες απαιτήσεις λειτουργικού συστήματος, επισκεφθείτε την:

http://www.deitel.com/books/AndroidHTP2

και πηγαίνετε στην ενότητα με επικεφαλίδα SYSTEM REQUIREMENTS. Αναπτύξαμε τις εφαρμογές 
αυτού του βιβλίου χρησιμοποιώντας το παρακάτω λογισμικό:

 Java SE 7 Software Development Kit

 Android SDK/ADT Bundle που βασίζεται στο Eclipse IDE

 Android SDK εκδόσεις 4.3 και 4.4

Στην επόμενη ενότητα σας λέμε πού θα βρείτε όλο αυτό το λογισμικό.

Εγκατάσταση του Java Development Kit (JDK)
Το Android απαιτεί το Java Development Kit (JDK) (κιτ ανάπτυξης Java) έκδοση 7 ή 6 (JDK 6). Εμείς χρη-
σιμοποιήσαμε το JDK 7. Για να φορτώσετε το JDK για Windows, OS X ή Linux, μεταβείτε στην

http://www.oracle.com/technetwork/java/javase/downloads/index.html

Χρειάζεστε μόνο το JDK. Επιλέξτε την έκδοση 32-bit ή 64-bit, ανάλογα με το υλικό και το λειτουργικό 
σύστημα του υπολογιστή σας. Οι περισσότεροι σύγχρονοι υπολογιστές έχουν υλικό 64-bit – απλώς, 
δείτε τις προδιαγραφές του συστήματός σας. Αν έχετε λειτουργικό σύστημα 32-bit, πρέπει να χρησι-

Πριν να 
Αρχίσετε
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μοποιήσετε το JDK 32-bit. Βεβαιωθείτε ότι έχετε ακολουθήσει τις οδηγίες εγκατάστασης που βρίσκο-
νται στην

http://docs.oracle.com/javase/7/docs/webnotes/install/index.html

Επιλογές Ολοκληρωμένου Περιβάλλοντος Ανάπτυξης (IDE) του Android
Η Google παρέχει σήμερα δύο επιλογές Android IDE:

 Πακέτο Android SDK/ADT – μια έκδοση του Eclipse IDE, που προσφέρεται προδιαμορφωμένη 
με την πιο πρόσφατη έκδοση του Android Software Development Kit (SDK) και την πιο πρό-
σφατη έκδοση του πρόσθετου Android Development Tools (ADT). Μέχρι την ώρα της συγγρα-
φής του βιβλίου, αυτές ήταν η έκδοση Android SDK 4.4 και η έκδοση ADT 22.3.

 Android Studio – Το νέο Android IDE της Google, που βασίζεται στο IntelliJ® IDEA και στο προ-
τιμώμενο μελλοντικό IDE.

Το πακέτο Android SDK/ADT έχει χρησιμοποιηθεί ευρέως για ανάπτυξη εφαρμογών Android για αρκετά 
χρόνια. Το Android Studio, που παρουσιάστηκε τον Μάιο του 2013, είναι μια πρώιμη έκδοση προσπέ-
λασης, που θα εξελιχθεί γρήγορα. Για αυτόν τον λόγο, εμείς θα χρησιμοποιήσουμε το ευρέως χρησι-
μοποιούμενο πακέτο Android SDK/ADT, και σαν ηλεκτρονικά συμπληρώματα στην

http://www.deitel.com/books/AndroidHTP2

θα παρέχουμε τις εκδόσεις Android Studio στην ενότητα ∆οκιμαστικής Εκτέλεσης στο Κεφάλαιο 1 και 
στην ενότητα περί της δημιουργίας της Γ∆Χ για κάθε εφαρμογή, όταν αυτό χρειάζεται.

Εγκατάσταση του Πακέτου Android SDK/ADT
Για να κατεβάσετε το πακέτο Android SDK/ADT πηγαίνετε στο

http://developer.android.com/sdk/index.html

και κάντε κλικ στο κουμπί Download the SDK ADT Bundle. Όταν ολοκληρωθεί το κατέβασμα, εξάγετε 
τα περιεχόμενα του αρχείου ZIP στο σύστημά σας. Ο προκύπτων φάκελος περιέχει ένα υποφάκελο 
eclipse, ο οποίος περιέχει το Eclipse IDE και έναν υποφάκελο sdk, που περιέχει το Android SDK. 
Όπως και με το JDK, μπορείτε να επιλέξετε την έκδοση 32-bit ή 64-bit. Η έκδοση 32-bit του πακέτου 
Android SDK/ADT πρέπει να χρησιμοποιηθεί με το JDK 32-bit και η έκδοση 64-bit με το JDK 64-bit.

Εγκατάσταση του Android Studio
Οι οδηγίες για το IDE μέσα στο βιβλίο χρησιμοποιούν το πακέτο Android SDK/ADT. Μπορείτε επίσης 
προαιρετικά να εγκαταστήσετε και να χρησιμοποιήσετε το Android Studio. Για να κατεβάσετε το 
Android Studio, πηγαίνετε στο

http://developer.android.com/sdk/installing/studio.html

και κάντε κλικ στο κουμπί Download Android Studio. Όταν ολοκληρωθεί το κατέβασμα, εκτελέστε το 
πρόγραμμα εγκατάστασης και ακολουθήστε τις οδηγίες που παρουσιάζονται στην οθόνη, για να ολο-
κληρώσετε την εγκατάσταση. [Σημείωση: Για ανάπτυξη με το Android 4.4 μέσα στο Android Studio, 
το Android υποστηρίζει σήμερα τα χαρακτηριστικά Java SE 7 της γλώσσας, που περιλαμβάνουν έναν 
τελεστή ρόμβο, πολλαπλές catch, String μέσα σε switch και try με πόρους.]

Καθορισμός του Επιπέδου Συμμόρφωσης του Μεταγλωττιστή Java και Εμφάνιση 
Αριθμών Γραμμών
Το Android δε υποστηρίζει πλήρως το Java SE 7. Για να διασφαλίσετε ότι τα παραδείγματα του βιβλίου 
μεταγλωττίζονται σωστά, παραμετροποιήστε το Eclipse, ώστε να παράγει αρχεία, τα οποία είναι 
συμβατά με το Java SE 6, κάνοντας τα παρακάτω βήματα:
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1. Ανοίξτε το Eclipse (  ή ), το οποίο βρίσκεται μέσα στον υποφάκελο eclipse του φακέλου 
εγκατάστασης του πακέτου SDK/ADT.

2. Όταν εμφανιστεί το παράθυρο Workspace Launcher, κάντε κλικ στο OK.

3. Επιλέξτε Window > Preferences για να εμφανίσετε το παράθυρο Preferences. Στο Mac OS X, 
επιλέξτε ADT > Preferences…..

4. Αναπτύξτε τον κόμβο Java και επιλέξτε τον κόμβο Compiler. Κάτω από το JDK Compliance, 
θέστε το Compiler compliance level σε 1.6 (για να δηλώσετε ότι το Eclipse πρέπει να παράγει 
μεταγλωττισμένο κώδικα, που είναι συμβατός με το Java SE 6).

5. Αναπτύξτε τον κόμβο General > Editors και επιλέξτε TextEditors και μετά σιγουρευτείτε ότι 
είναι επιλεγμένο το Show line numbers και κάντε κλικ στο OK.

6. Κλείστε το Eclipse.

Android 4.3 SDK
Τα παραδείγματα αυτού του βιβλίου γράφτηκαν χρησιμοποιώντας τα Android 4.3 και 4.4 SDK. Μέχρι 
την ώρα της συγγραφής αυτού του βιβλίου, η έκδοση 4.4 ήταν η έκδοση που περιλαμβανόταν στο 
πακέτο Android SDK/ADT και στο Android Studio. Πρέπει να εγκαταστήσετε επίσης το Android 4.3 
(και τυχόν άλλες εκδόσεις που θέλετε να υποστηρίζονται μέσα στις εφαρμογές σας). Για να εγκατα-
στήσετε άλλες εκδόσεις της πλατφόρμας Android, κάντε τα παρακάτω βήματα (παρακάμπτοντας 
τα Βήματα 1 και 2, αν το Eclipse είναι ήδη ανοικτό):

1.  Ανοίξτε το Eclipse. Ανάλογα με την πλατφόρμα σας, το εικονίδιο θα εμφανιστεί σαν  ή .

2. Όταν εμφανιστεί το παράθυρο Workspace Launcher, κάντε κλικ στο OK.

3. Στο Mac OS X, αν δείτε ένα παράθυρο, που λέει «Could not find SDK folder ‘/Users/Ο Λογα-
ριασμός σας/android-sdk-macosx/’» κάντε κλικ στο Open Preferences και μετά στο Browse… 
και επιλέξτε τον φάκελο sdk, που βρίσκεται, εκεί όπου εξάγατε το πακέτο SDK/ADT Android.

4. Επιλέξτε Window > Android SDKManager για να εμφανίσετε το παράθυρο Android SDK 
Manager (Εικόνα 1).

Εικόνα 1 Παράθυρο Android SDK Manager.

5. Η στήλη Name του Android SDK Manager δείχνει όλα τα εργαλεία, τις εκδόσεις πλατφόρμας 
και τα πρόσθετα (π.χ., τις API για αλληλεπίδραση με τις υπηρεσίες Google, όπως την Maps), 
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που μπορείτε να εγκαταστήσετε. Αποεπιλέξτε το πλαίσιο ελέγχου Installed. Κατόπιν, αν εμφα-
νίζεται οποιοδήποτε από τα Tools, Android 4.4 (API19), Android 4.3 (API18) και Extras μέσα 
στην λίστα Packages, σιγουρευτείτε ότι είναι όλα επιλεγμένα, και κάντε κλικ στο Install # 
packages… (# είναι ο αριθμός των στοιχείων που θα εγκατασταθούν) για να εμφανίσετε το 
παράθυρο Choose Packages to Install. Τα περισσότερα στοιχεία μέσα στον κόμβο Extras είναι 
προαιρετικά. Για αυτό το βιβλίο, θα χρειαστείτε τα Android Support Library και Google Play 
services. Το Google USB Driver είναι απαραίτητο για χρήστες των Windows, οι οποίοι θέλουν 
να ελέγξουν εφαρμογές σε συσκευές Android.

6. Μέσα στο παράθυρο Choose Packages to Install, διαβάστε τις άδειες χρήσης για κάθε στοιχείο. 
Όταν τελειώσετε, κάντε κλικ στο κουμπί επιλογής Accept Licence και κατόπιν κάντε κλικ στο 
κουμπί Install. Η κατάσταση της διαδικασίας εγκατάστασης θα εμφανιστεί μέσα στο παράθυρο 
Android SDK Manager.

∆ημιουργία Εικονικών Συσκευών Android (AVD)
Ο εξομοιωτής Android, που περιλαμβάνεται μέσα στο Android SDK, σας επιτρέπει να εκτελέσετε 
εφαρμογές Android μέσα σ' ένα περιβάλλον εξομοίωσης στον υπολογιστή σας, αντί να τις εκτελέσετε 
σε μια πραγματική συσκευή Android. Αυτό μπορεί να σας φανεί χρήσιμο, αν μαθαίνετε Android και 
δεν έχετε πρόσβαση σε συσκευές Android, αλλά μπορεί να είναι πολύ αργός, οπότε είναι προτιμότερο 
να χρησιμοποιείτε μια πραγματική συσκευή, αν έχετε. Υπάρχουν ορισμένα χαρακτηριστικά επιτάχυν-
σης υλικού, τα οποία μπορούν να βελτιώσουν την απόδοση του εξομοιωτή (developer.android.
com/tools/devices/emulator.html#acceleration). Πριν να εκτελέσετε μια εφαρμογή μέσα 
στον εξομοιωτή, πρέπει να δημιουργήσετε μια Εικονική Συσκευή Android (Android Virtual Device, 
AVD), η οποία ορίζει τα χαρακτηριστικά της συσκευής, στην οποία θέλετε να κάνετε την δοκιμή, περι-
λαμβανομένων του μεγέθους της οθόνης, σε pixels, της πυκνότητας pixels, του φυσικού μεγέθους της 
οθόνης, του μεγέθους της κάρτας SD για αποθήκευση δεδομένων και άλλων πραγμάτων. Αν θέλετε 
να χρησιμοποιήσετε τις εφαρμογές σας για πολλαπλές συσκευές Android, μπορείτε να δημιουργήσετε 
ξεχωριστές AVD, που εξομοιώνουν κάθε συσκευή. Για αυτό το βιβλίο χρησιμοποιούμε AVD για τις 
συσκευές αναφοράς Android της Google – το τηλέφωνο Nexus 4, την μικρή ταμπλέτα Nexus 7 και την 
μεγάλη ταμπλέτα Nexus 10 – οι οποίες εκτελούν ατροποποίτητες εκδόσεις του Android. Για να το 
κάνετε αυτό, εκτελέστε τα παρακάτω βήματα:

1. Ανοίξτε το Eclipse.

2. Επιλέξτε Window > Android Virtual Device Manager ώστε να εμφανίσετε το παράθυρο Android 
Virtual Device Manager (Εικόνα 2.).

Εικόνα 2 Παράθυρο Android Virtual Device Manager.
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3. H Google παρέχει εκ των προτέρων παραμετροποιημένες συσκευές, τις οποίες μπορείτε να 
χρησιμοποιήσετε, για να δημιουργήσετε AVD. Επιλέξτε Nexus 4 by Google και μετά κάντε κλικ 
στο Create AVD ώστε να εμφανίσετε το παράθυρο Create new Android Virtual Device (AVD) 
(Εικόνα 3) και κατόπιν παραμετροποιήστε τις επιλογές, όπως φαίνεται και κάντε κλικ στο OK 
για να δημιουργήσετε την AVD. Αν επιλέξετε Hardware keyboard present, θα μπορέσετε να 
χρησιμοποιήσετε το πληκτρολόγιο του υπολογιστή σας για να πληκτρολογείτε δεδομένα μέσα 
σε εφαρμογές, οι οποίες εκτελούνται μέσα στην AVD, αλλά αυτό μπορεί να αποτρέψει την 
εμφάνιση του λογισμικού πληκτρολογίου στην οθόνη. Αν ο υπολογιστής σας δεν έχει κάμερα, 
μπορείτε να επιλέξετε Emulated για τις επιλογές Front Camera και Back Camera. Κάθε AVD 
που δημιουργείτε έχει πολλές άλλες επιλογές, οι οποίες καθορίζονται μέσα στο confi g.ini. 
Μπορείτε να τροποποιήσετε αυτό το αρχείο, όπως περιγράφεται στο

http://developer.android.com/tools/devices/managing-avds.html

 για να ταιριάξετε καλύτερα την παραμετροποίηση του υλικού της συσκευής σας.

Εικόνα 3 Παραμετροποίηση της AVD ενός smartphone Nexus 4 για το Android 4.3.

4. Έχουμε παραμετροποιήσει επίσης AVD Android 4.3, που αντιπροσωπεύουν τα Nexus 7 by 
Google και Nexus 10 by Google για έλεγχο των εφαρμογών μας σε ταμπλέτες. Οι ρυθμίσεις τους 
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παρουσιάζονται στην Εικόνα 4. Επίσης, παραμετροποιήσαμε AVD Android 4.4 για τα Nexus 4, 
Nexus 7 και Nexus 10 με ονόματα: AVD_for_Nexus_4_KitKat, AVD_for_Nexus_7_KitKat 
και AVD_for_Nexus_10_KitKat.

Εικόνα 4 Παραμετροποίηση των AVD των ταμπλετών Nexus 7 και Nexus 10.

(Προαιρετικό) ∆ιαμόρφωση μιας Συσκευής Android για Ανάπτυξη
Όπως αναφέραμε, ο έλεγχος εφαρμογών σε AVD μπορεί να είναι αργός, λόγω της απόδοσης των 
AVD. Αν έχετε στην διάθεσή σας μια συσκευή Android, πρέπει να ελέγξετε τις εφαρμογές σ' αυτήν την 
συσκευή. Επίσης, υπάρχουν ορισμένα χαρακτηριστικά, τα οποία μπορείτε να ελέγξετε μόνο σε πραγ-
ματικές συσκευές. Για να εκτελέσετε τις εφαρμογές σας σε συσκευές Android, ακολουθήστε τις οδη-
γίες που παρουσιάζονται στο

http://developer.android.com/tools/device.html

Αν κάνετε ανάπτυξη για τα Microsoft Windows, θα χρειαστείτε επίσης το πρόγραμμα οδήγησης 
Windows USB driver για συσκευές Android. Σε ορισμένες περιπτώσεις, στα Windows, μπορεί να χρει-
αστείτε επίσης προγράμματα οδήγησης USB για συγκεκριμένες συσκευές. Για μια λίστα των διαφόρων 
ιστοθέσεων με προγράμματα οδήγησης USB για διάφορες εταιρείες συσκευών, επισκεφθείτε την 
ιστοθέση:

http://developer.android.com/tools/extras/oem-usb.html
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Λήψη των Παραδειγμάτων Κώδικα
Τα παραδείγματα του βιβλίου διατίθενται για κατέβασμα, από την διεύθυνση

http://www.deitel.com/books/AndroidHTP2/

Αν δεν είστε ήδη εγγεγραμμένος στην ιστοθέση μας, πηγαίνετε στην www.deitel.com και κάντε κλικ 
στην σύνδεση Register. Συμπληρώστε τις πληροφορίες σας. Η εγγραφή είναι δωρεάν και δεν θα μοι-
ραστούμε τις πληροφορίες σας με κανέναν. Επαληθεύστε ότι εισάγατε σωστά την διεύθυνση e-mail 
εγγραφής σας - θα δεχθείτε ένα e-mail επιβεβαίωσης, με τον κωδικό. Πρέπει να κάνετε κλικ στην σύν-
δεση επαλήθευσης μέσα στο e-mail, για να εγγραφείτε στην www.deitel.com για πρώτη φορά. ∆ια-
μορφώστε τον πελάτη σας e-mail, ώστε να δέχεται e-mail απ' την deitel.com, για να σιγουρευτείτε 
ότι το e-mail επιβεβαίωσης δεν θα φιλτραριστεί σαν σκουπίδια. Σας στέλνουμε περιστασιακά e-mail 
διαχείρισης λογαριασμού, εκτός και αν εγγραφείτε για το δωρεάν παρεχόμενο ενημερωτικό μας δελτίο 
Deitel® Buzz Online, στην διεύθυνση

http://www.deitel.com/newsletter/subscribe.html

Στην συνέχεια, επισκεφθείτε την www.deitel.com και εγγραφείτε χρησιμοποιώντας την σύνδεση 
Login, που βρίσκεται κάτω απ' το λογότυπο, στην επάνω αριστερή γωνία της σελίδας. Πηγαίνετε 
στην www.deitel.com/books/AndroidHTP2/. Κάντε κλικ στην σύνδεση Examples για να κατεβά-
σετε το αρχείο ZIP στον υπολογιστή σας. Κάντε διπλό κλικ στο αρχείο ZIP ώστε να αποσυμπιέσετε 
την αρχειοθήκη και σημειώστε πού εξάγατε τα περιεχόμενα του αρχείου μέσα στο σύστημά σας.

Μια Σημείωση για τα Εργαλεία Ανάπτυξης Android
Η Google ενημερώνει συχνά τα εργαλεία ανάπτυξης Android. Αυτό συχνά οδηγεί σε προβλήματα κατά 
την μεταγλώττιση των εφαρμογών σας, αν και οι εφαρμογές σας δεν περιέχουν σφάλματα. Αν εισάγετε 
μια απ' αυτές τις εφαρμογές μέσα στο Eclipse ή μέσα στο Android Studio και δεν μεταγλωττιστεί, 
πιθανώς θα υπάρχει ένα μικρό πρόβλημα παραμετροποίησης. Μπορείτε να έλθετε σε επαφή με μας, 
μέσω e-mail, στην διεύθυνση deitel@deitel.com αναρτώντας μια ερώτηση στα:

 Facebook®—facebook.com/DeitelFan

 Google+™—google.com/+DeitelFan

και θα σας βοηθήσουμε να επιλύσετε το πρόβλημα.

Τώρα έχετε εγκαταστήσει όλο το λογισμικό και έχετε κατεβάσει τα παραδείγματα κώδικα, που θα 
χρειαστείτε ώστε να μελετήσετε την ανάπτυξη εφαρμογών Android με το βιβλίο Android Προγραμμα-
τισμός και είστε έτοιμοι να αρχίσετε να αναπτύσσετε τις δικές σας εφαρμογές. ∆ιασκεδάστε το!
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